# Table of contents

## 1. About this document

  1.1 Documentation version history  
  1.2 Legend

## 2. Content

  2.1 Introduction  
  2.2 Analog in  
  2.3 Channel setup  
  2.4 Basic settings  
  2.5 Probe settings
    2.5.1 Probe setup  
    2.5.2 Sound intensity probe
  2.6 Measurement settings
    2.6.1 Environment  
    2.6.2 Octave analysis  
    2.6.3 Frequency weighting  
    2.6.4 Averaging time  
    2.6.5 Logged measurement mode  
    2.6.6 Standard indicators
      2.6.7 PRI measurement

## 3. Measurement screen

  3.1 Instantaneous SI mode  
  3.2 Logged SI mode  
  3.3 Sound Intensity - ISO 9614
    3.3.1 Sound intensity map
  3.4 Measurement controls
    3.4.1 Sound power spectra and overall values  
    3.4.2 SI probe remote control  
    3.4.3 Standard indicators table
      ISO 9614-1  
      ISO 9614-2

## 4. Analysis

  4.1 Logged mode  
  4.2 Offline math
    4.2.1 Offline math - recalculation from raw data  
    4.2.2 Offline math - Power transformers
      Channel setup  
      Measurement  
      Analysis and recalculation
5. Export & Report

6. Warranty information
   6.1 Calibration
   6.2 Support
   6.3 Service/repair
   6.4 Restricted Rights
   6.5 Printing History
   6.6 Copyright
   6.7 Trademarks
1. About this document

This is the user manual for the Sound Intensity software module.

1.1 Documentation version history

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0</td>
<td>1.4.2020</td>
<td>Initial revision</td>
</tr>
<tr>
<td>1.1.</td>
<td>18.4.2020</td>
<td>Updated with power transformers method</td>
</tr>
<tr>
<td>1.2.</td>
<td>20.4.2020</td>
<td>Updated with triggered channels</td>
</tr>
</tbody>
</table>

1.2 Legend

The following symbols and formats will be used throughout the document.

**Important**
- Gives you important information about a subject.
- Please read carefully!

**Hint**
- Gives you a hint or provides additional information about a subject.

**Example**
- Gives you an example of a specific subject.
2. Content

2.1 Introduction

The Dewesoft X Sound Intensity module is a powerful software tool for performing intensity based sound power ratings of devices under test in accordance with ISO 9614-1 and 9614-2 standards. The method offers unique advantages as power measurements can be done on site, no need for a designated environment. Furthermore, devices under test are not limited in size and the measurement method itself is simple and quick.

Besides ISO compliant sound power ratings, Sound Intensity plugin can be used for quick noise source location (Instantaneous SI mode) and more detailed rapid troubleshooting (Logged mode) when synced with a video input from a camera.

\[
\begin{align*}
\text{Li} & \quad \text{Sound intensity} \\
\text{Lp} & \quad \text{Sound pressure} \\
\text{Lw} & \quad \text{Sound power}
\end{align*}
\]

Additional information about Dewesoft sound intensity measurement solution can be found on our website, where the latest version of the module can also be downloaded.

2.2 Analog in

Sound intensity probe consists of a microphone pair, meaning two analog inputs are used for connection. Depending whether the probe uses a prepolarized microphone pair or an externally polarized one, the measurement chain will be different and the Measurement column needs to be set accordingly. For prepolarized intensity probes it should be set to IEPE and when using an externally polarized probe with a power module, measurement should be set to Voltage.

2.3 Channel setup

In the channel setup section of the sound intensity plugin different measurement parameters are set through a designated user interface. The settings are divided into three major sections.
2.4 Basic settings

Dewesoft Sound Intensity plugin supports sound power calculation and ratings of equipment based on sound intensity measurement according to ISO 9614-1 point-to-point and ISO 9614-2 sweep standards.

In the first dropdown the method according to one of the two standards can be selected. If ISO 9614-1 is selected, the probe must be moved in a point to point manner, always measuring at the center of an individual segment.
When measuring according to ISO 9614-2 the probe shall be moved over the entire segment (usually one segment per surface) in a sweep-like manner, as shown in the picture below.

Depending on the selected standard there are different grades of accuracy available to choose from in the following dropdown. Each grade of accuracy has its corresponding Bias error defined; 10 dB for Precision and Engineering and 7 dB for Survey method. The higher the bias error the more strict is the evaluation of standard indicators: PRI vs PI, meaning the higher the requirements for the measurement equipment and environment.
Under **Measurement surface setup** section three different surface shapes can be selected, each corresponding to a different use case/measurements scenario:

**Surface shape - Parallelepiped**

*Parallelepiped* is used to perform five surface noise mapping and sound power ratings of different devices under test. Sound power can be calculated by measuring the sound intensity over the entire enclosed service and knowing the area of the enclosed surface. Each of the five surfaces can have an
individually defined number of segments, depending on the unit under test. The higher the number, the better the resolution of the noise map on the individual surface.

Surface shape - **One side**

A single measurement surface is used whenever trying to obtain a noise map of a single surface or when measuring sound power, emitted through this single surface. A common example would be the cooling vent on a larger structure, where noise is produced by the ventilator and is only propagated through a single outlet. The number of segments can be defined according to the desired resolution of the noise map. When measuring according to ISO 9614-2 sweep method, a single segment is defined for the entire surface.
In custom mode, any number of single surfaces can be defined. They are customizable with individual names and number of segments.
2.5 Probe settings

2.5.1 Probe setup

In Microphone spacing dropdown, different spacer dimensions can be selected for the intensity probe. According to the selected spacer dimension, software gives you the recommended frequency range of the measurement.

<table>
<thead>
<tr>
<th>Microphone spacing</th>
<th>Recommended frequency range</th>
</tr>
</thead>
<tbody>
<tr>
<td>12 mm</td>
<td>200 Hz - 10000 Hz</td>
</tr>
</tbody>
</table>

There are five different spacer dimensions with different recommended frequency ranges:

- 100 mm: 30-1000 Hz
- 50 mm: 80-1500 Hz
- 25 mm: 120-5000 Hz
- 12 mm: 200-10000 Hz
- 6 mm: 1000-12000 Hz*

*Used with a quarter inch microphone pair.

2.5.2 Sound intensity probe

Probe type dropdown enables selection of different intensity probes. By default, remote control functionality of the most common probes is supported; G.R.A.S. 50GI-R (supplied in our SI solution package) and B&K Type 3599.

Selecting “Enable remote control” tick box enables the user to operate the measurement via the intensity probe’s remote.
Before launching the measurement, a correct COM port needs to be assigned to the remote. This is done in: Options>Settings>Extensions>Sound intensity

When “Measure before next” is selected, the software will prevent users from skipping any segments that were not measured. This way, they have to all be measured consecutively; each individual segment must have a measured value before moving to the next one.

Next, under the Microphone section of channel setup, the correct analog inputs need to be assigned to MIC A and MIC B.

To make things easier, analog inputs can be renamed according to the microphone that is connected. This can be done in Analog in the section of the setup.

Below the microphone section there are two additional check boxes:
Store probe channels: When selected, the system will also store raw sound pressure signals from both of the microphones. This makes datafiles larger, but enables offline recalculation of sound intensity.

Store measurement workflow: Octave spectra for individual segments will be stored along with the history of averaging. By default, this checkbox is unchecked as system is configured for sound power ratings according to ISO 9614 where end result is one sound power spectrum for the entire surface (entire device under test).

Under the **Trigger** section of setup a trigger channel can be selected from the dropdown for control of movement through segments.

![Trigger Channel Setup](image)

Depending on the signal used, in the **Level** input field the level of the trigger signal needs to be entered and **Hysteresis** set to the corresponding value. In dropdown either a **Positive** or **Negative** slope can be selected.

Having configured the trigger correctly, the system will wait for the trigger signal to start and stop the measurement and move through segments automatically according to the **Movement** direction selected next to the **Averaging time**.

![Averaging Time](image)

### 2.6 Measurement settings

#### 2.6.1 Environment

For correct calculation of sound intensity and consequently sound power, correct environmental conditions should be entered in the setup under Environment section of channel setup. After entering the temperature, barometric pressure and relative humidity, the system will determine air density automatically.

![Environment Section](image)
2.6.2 Octave analysis

Here, the frequency limits of octave analysis are set. By default, they are linked to the recommended frequency range of the spacer in use. The frequency limit bands can be unlocked in order to calculate only in a certain frequency range or when using more than one spacer for the measurement. When two spacers are used, the frequency ranges should be configured with no overlap or skipped frequencies.

For example: first measurement with 100 mm spacer from 31.5 Hz to 1000 Hz and then the second measurement with 12 mm spacer from 1000 Hz to 10000 Hz. By simply adding the two results together, the entire range from 31.5 Hz to 10000 Hz has been covered.

2.6.3 Frequency weighting

Depending on the desired results, Linear or A frequency weightings can be selected. By default, A-weighting is selected as sound power ratings according to ISO 9614 are measured in dB(A).

2.6.4 Averaging time

When it comes to measuring an individual segment on our grid, the averaging duration can be manually controlled by clicking the Start/Stop button on the Measure screen or pressing the button on the probe’s remote. However, automatic averaging time can be defined to ensure repeatability of measurement conditions on each segment. This is achieved by selecting the Auto stop checkbox and inputting the desired averaging time in the Segment Measurement bracket.
This way acquisition of a segment needs to be initiated only and the system will stop it automatically after averaging for the user-selected amount of time.

Tip: shorter averaging times are used for devices with relatively constant noise characteristics. On the opposite, less constant noise sources require longer averaging times for accurate results.

Furthermore, measurement procedure can be additionally automatized by selecting Auto next column checkbox. Now the system will move to the next column automatically and measure each segment for the selected amount of time.

### 2.6.5 Logged measurement mode

Logged measurement enables toggling logged measurement mode on or off by selecting the Store logged checkbox. Next to the checkbox there is also a bracket for specifying the logged measurement interval. Logged measurement mode will log sound intensity values vs. time in this predefined interval and also store an intensity octave spectrum for each logged point. It is very powerful when used in conjunction with a video camera, enabling rapid evaluation of devices in terms of emitted noise and accurate control of the probe's position. Logged measurement mode is further explained in the Measurement screen section.

### 2.6.6 Standard indicators

When measuring according to ISO 9614 standards, there is a set of standard indicators that are used to evaluate the state of measurement equipment and also measurement environment. One of the most important indicators is the Pressure - residual intensity index that is used to describe the accuracy of the measurement system in terms of phase match. The better the phase match, the higher the PRI the
more accurate are the results. By default, the PRI checkbox is selected and PRI measurement supported, but can be toggled off whenever not needed, according to the user’s preference.

2.6.7 PRI measurement

Evaluation of the PRI index is done in a designated phase calibrator, that supplies the same signal (white or pink noise) to both of the microphones on the intensity probe. After setting up the probe’s microphones in the phase calibrator and powering it on, PRI index evaluation is performed by simply clicking the **Start PRI** button inside the measurement screen. ISO 9614 requires PRI to be averaged for 32 seconds, so this is the default value set by the system.

Besides using a phase calibrator to measure it, PRI measurement can also be a standard part of yearly equipment calibration performed by an accredited calibration laboratory. Dewesoft sound intensity software supports also manual entry of PRI values from the calibration chart issued by the calibration laboratory. A predefined table for entry of PRI values is opened when selecting the **PRI editor** button.

Whenever a phase correction was performed in measure mode, it can easily be reset by selecting the **Reset ph. correction** button. Phase correction is a tool supported in Dewesoft Sound intensity to further improve the phase match of the entire measurement system. It requires placing the microphones inside the same type of phase calibrator as for the PRI measurement and can also be performed with a single button click when in **Measure** mode.
3. Measurement screen

Dewesoft sound intensity software has three major pre-defined modes of operation:

- Instantaneous SI mode
- Logged SI mode
- Sound power rating mode

3.1 Instantaneous SI mode

This mode supports fast, live noise source localisation for rapid investigation of different noise sources. When in Measure, simply click on **Display** then + and select **Instantaneous SI** from the list of available displays.

Instantaneous SI display consists of two octave displays; one for instantaneous sound pressure (Lp) averaged between both microphones on the probe and one octave display for instantaneous sound intensity (Li) values. Both pressure and intensity are displayed in overall values on digital displays as well. Since sound intensity is a vector quantity, band-by-band and overall intensity directions are displayed as well, representing crucial information when it comes to noise source localisation.
Example of how directional properties of intensity probe can be used when localizing the noise sources in space can be seen below:

3.2 Logged SI mode

Logged intensity mode takes the instantaneous SI mode to a higher level by logging in predefined time intervals the sound intensity spectrum and overall values vs. time. As opposed to instantaneous SI display, which is meant for live use in Measure mode only, logged SI values can be stored in a datafile and reviewed later on in Analyse.Logged intensity mode is most powerful when merged with a video input for intensity probe’s position control. For this purpose, a simple webcam can be used, or any DirectX supported camera - measured data and video input are automatically synced by the software.
3.3 Sound Intensity - ISO 9614

For the regulatory purposes, manufacturers of different types of equipment are often required to issue sound power ratings when placing their products on the market. Dewesoft sound intensity solution is compliant with ISO 9614 measurement methods and is thus the perfect tool for performing sound power ratings. After configuring **Analog in** and **Channel setup** tabs a predefined screen for ISO 9614 measurements is available when clicking **Measure**. There are four main parts of the measurement display as outlined in the picture below.
1 - Sound intensity map with measurement controls, 2 - Sound power spectra and overall values, 3 - Standard indicators table, and 4 - Measurement status

3.3.1 Sound intensity map

During the measurement, an intensity map is coloured according to the values of individual segments on the defined measurement grid. For a better representation, an image can easily be loaded as a background of the measurement grid.

When clicking on the intensity map widget, a list of settings is displayed to the left of the map:
● **Load image** - a background image can be selected from the images on the computer.

● **Edit grid** - selecting this checkbox allows resizing of the grid by clicking and dragging the yellow triangles on the bottom left and upper right corners of the grid.

● **Reset grid position** - resets grid position. If a background image is used, this means resizing as per selected image size. If no background image is used, the system resizes the grid according to the borders of the widget.

● **Colormap** - select from different colormaps in the dropdown; Spring, Summer, Autumn, Winter, Gray, Jet, Hot, Cool.

● **Frequency range Min & Max** - select min and max frequency to be included in the intensity values shown on the intensity map widget.

### 3.4 Measurement controls

Measurement controls consist of a set of buttons located right below the sound intensity map. These buttons allow the user to control the measurement directly from the PC and are most often used with intensity probes that have no remote control.

- **Start/Stop** - starts the acquisition/measurement. Changes from **Start** to **Stop** once measurement was started.

- **Start F1** - starts measurement of F1 - temporal variability factor. Is measured with the intensity probe positioned statically at the center of one of the measurement faces. Further explained in the **Standard indicators** section below.

- **Start PRI** - starts measurement of pressure residual intensity index. Probe needs to be placed in the appropriate phase calibrator and white noise is played to both microphones.

- **Start Ph. c.** - measures phase mismatch and performs phase correction - improves phase match and widens the measurement frequency range. Probe needs to be in phase calibrator, exactly the same as with the PRI measurement. Correction is applied automatically by the software.

- **Up, Down, Left, Right** - control the movement between segments on the measurement grid. Currently selected segment is outlined by a yellow bracket.

- **Prev. & Next** - control the movement between individual measurement faces.

In addition to the above buttons there is also a digital display for elapsed time of current segment acquisition and an LED indicator. When the indicator is red, the system is idling and when it turns green the sound intensity acquisition is in progress.
3.4.1 Sound power spectra and overall values

By default, there are three octave displays on the predefined measurement screen:
- Curr. segment Lw: sound power octave spectrum for current segment
- Curr. face Lw: sound power octave spectrum for current face
- Surface Lw: sound power octave spectrum for the complete surface

Besides the octave displays there is a set of digital displays for overall values of sound power, intensity and pressure.

3.4.2 SI probe remote control

Remote control functionality is supported for the most common probe models. As a part of our complete solution we are using a 50GI-R probe from G.R.A.S. that features a two button remote shown below:

Grey button: single press to Start/Stop the measurement
Blue button: single press to move to the next segment, double press to move to the next face

Very similar to the LED indicator on the Measure screen, the LEDs on the remote are used to display the current status of the measurement:
- LED is red: system is in idle, waiting for button press to start acquisition
- LED is green: acquisition/measurement is in progress
- Both LEDs red: measurement of all segments is completed

3.4.3 Standard indicators table
In order to achieve the desired grade of accuracy, ISO 9614 standards define a set of indicators that check for the adequacy of the measurement equipment and measurement field conditions. Dewesoft Sound intensity solution supports straightforward measurement and evaluation of these indicators.

Individual indicators are evaluated with a single button click or automatically during the measurement itself. Values of the indicators are then written in the designated table and automatically checked according to the criteria stated in the ISO 9614. Based on the evaluation of indicators, the user is notified in a designated column of the results and potential actions to take in order to increase measurement accuracy. Details on how each indicator is measured are explained below, they are slightly different for ISO 9614-1 and 9614-2

**ISO 9614-1**

<table>
<thead>
<tr>
<th>Frequency (Hz)</th>
<th>PRI index (dB)</th>
<th>Ld (dB)</th>
<th>Cur. face F1 (CPI) (dB)</th>
<th>Cur. face F2 (CPI) (dB)</th>
<th>Cur. face F3 (CPI) (dB)</th>
<th>Cur. face F4 (CPI) (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>200.00</td>
<td>30.13</td>
<td>20.13</td>
<td>0.00</td>
<td>6.47</td>
<td>6.47</td>
<td>1.15</td>
</tr>
<tr>
<td>250.00</td>
<td>34.67</td>
<td>24.67</td>
<td>0.00</td>
<td>9.39</td>
<td>10.42</td>
<td>12.47</td>
</tr>
<tr>
<td>315.00</td>
<td>30.34</td>
<td>20.34</td>
<td>0.00</td>
<td>5.41</td>
<td>5.41</td>
<td>2.21</td>
</tr>
<tr>
<td>400.00</td>
<td>28.10</td>
<td>18.10</td>
<td>0.00</td>
<td>4.04</td>
<td>4.94</td>
<td>2.27</td>
</tr>
<tr>
<td>500.00</td>
<td>26.79</td>
<td>16.79</td>
<td>0.00</td>
<td>4.90</td>
<td>5.90</td>
<td>3.89</td>
</tr>
<tr>
<td>630.00</td>
<td>26.58</td>
<td>16.58</td>
<td>0.00</td>
<td>4.35</td>
<td>4.35</td>
<td>6.22</td>
</tr>
<tr>
<td>800.00</td>
<td>27.90</td>
<td>17.90</td>
<td>0.00</td>
<td>5.48</td>
<td>5.48</td>
<td>15.65</td>
</tr>
<tr>
<td>1000.00</td>
<td>28.41</td>
<td>18.41</td>
<td>0.00</td>
<td>4.18</td>
<td>4.18</td>
<td>6.76</td>
</tr>
<tr>
<td>1250.00</td>
<td>29.24</td>
<td>19.24</td>
<td>0.00</td>
<td>4.07</td>
<td>4.07</td>
<td>3.97</td>
</tr>
<tr>
<td>1600.00</td>
<td>29.01</td>
<td>19.01</td>
<td>0.00</td>
<td>5.05</td>
<td>5.05</td>
<td>3.48</td>
</tr>
<tr>
<td>2000.00</td>
<td>28.34</td>
<td>18.34</td>
<td>0.00</td>
<td>3.80</td>
<td>3.80</td>
<td>2.82</td>
</tr>
<tr>
<td>2500.00</td>
<td>29.55</td>
<td>19.55</td>
<td>0.00</td>
<td>3.21</td>
<td>3.21</td>
<td>3.09</td>
</tr>
<tr>
<td>3150.00</td>
<td>29.91</td>
<td>19.91</td>
<td>0.00</td>
<td>3.42</td>
<td>3.42</td>
<td>3.28</td>
</tr>
<tr>
<td>4000.00</td>
<td>30.20</td>
<td>20.20</td>
<td>0.00</td>
<td>3.90</td>
<td>4.00</td>
<td>21.82</td>
</tr>
<tr>
<td>6000.00</td>
<td>31.04</td>
<td>21.04</td>
<td>0.00</td>
<td>3.63</td>
<td>3.63</td>
<td>28.70</td>
</tr>
</tbody>
</table>

- **PRI - Pressure-residual intensity index**
  The difference between indicated Lp and Li, when the intensity probe is placed and oriented in a sound field such that the sound intensity is zero. Such a sound field is established inside a phase calibrator that encapsulates both probe’s microphones and excites them with a broadband noise signal. PRI is expressed in decibels [dB].

- **Ld - Dynamic capability index**
  Also expressed in decibels. It equals PRI index minus the bias error defined for each grade of accuracy - 10dB for Precision and Engineering and 7dB for Survey.

- **F1 - Temporal variability indicator**
  Usually evaluated immediately before and immediately after the measurement on any one measurement surface. Performed by clicking the Measure F1 button found in Measurement controls part of the display.

- **F2 - Surface pressure-intensity indicator**
  Automatically calculated during the measurement from surface sound pressure level and surface intensity level. Both quantities are in decibels [dB]

- **F3 - Negative partial power indicator**
Automatically calculated during the measurement. It represents the difference between surface sound pressure level and normal normal signed intensity level; both in decibels [dB]

- **F4 - Field non-uniformity indicator**
  Automatically calculated during the normal course of measurement.

After all of the indicators have been measured, Dewesoft sound intensity software checks for fulfillment of mathematical criteria in accordance to ISO 9614-1 standard. According to the obtained criteria a message is displayed in the designated table column. The message either confirms criteria fulfillment (OK) or prompts the user to take action in order to increase the measurement accuracy.

Different actions as described in ISO 9614-1 are explained in the following table.

**Table of actions ISO 9614-1**

<table>
<thead>
<tr>
<th>Action code</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>e</td>
<td>Take action to reduce the temporal variability of extraneous intensity, or measure during periods of less variability, or increase the measurement period at each position (if appropriate).</td>
</tr>
<tr>
<td>a or b</td>
<td>In the presence of significant extraneous noise and/or strong reverberation, reduce the average distance of the measured surface from the source to a minimum average value of 0.25 m. In the absence of significant extraneous noise and/or strong reverberation, increase the average measured distance to 1 m. Shield measurement surface from extraneous noise sources or take action to reduce sound reflections towards the source.</td>
</tr>
<tr>
<td>c</td>
<td>Increase the density of measurement positions uniformly in order to satisfy criterion 2*.</td>
</tr>
<tr>
<td>d</td>
<td>Increase average distance of measurement surface from source using the same number of measurement positions, or increase the number of measurement positions on the same surface.</td>
</tr>
</tbody>
</table>

*Criterion 2 checks for the adequacy of the chosen array of measurement positions.

**ISO 9614-2**
● **PRI - Pressure-residual intensity index**
The difference between indicated $L_p$ and $L_i$, when the intensity probe is placed and oriented in a sound field such that the sound intensity is zero. Such a sound field is established inside a phase calibrator that encapsulates both probe’s microphones and excites them with a broadband noise signal. PRI is expressed in decibels [dB].

● **Ld - Dynamic capability index**
Also expressed in decibels. It equals PRI index minus the bias error defined for each grade of accuracy - 10dB for Precision and Engineering and 7dB for Survey.

● **Fpl - Surface pressure-intensity indicator**
Automatically calculated during the measurement from surface sound pressure level and surface intensity level. Both quantities are in decibels [dB].

● **F+/- - Negative partial power indicator**
Automatically determined during the measurement using partial sound power. Partial sound power is the Time-averaged rate of flow of sound energy through an element (segment) of a measurement surface and is calculated with the signed magnitude of the segment-average normal sound intensity.

After all of the indicators have been measured, Dewesoft sound intensity software checks for fulfillment of mathematical criteria in accordance to ISO 9614-2 standard. According to the obtained criteria a message is displayed in the designated table column. The message either confirms criteria fulfillment(OK) or prompts the user to take action in order to increase the measurement accuracy.
Different actions as described in ISO 9614-2 are explained in the following table:

**Table of actions ISO 9614-2**

<table>
<thead>
<tr>
<th>Action code</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>a or b or f</strong></td>
<td>Halve the average distance of the measurement surface from source to not less than a minimum average value of 100 mm and double the scan-line density. Shield the measurement surface from strong extraneous noise sources by</td>
</tr>
<tr>
<td><strong>a or f</strong></td>
<td>Halve the average distance of the measurement surface from source to not and less than a minimum average value of 100 mm and double the scan-line density. Reduce the adverse influence of the reverberant sound field by introducing additional absorption into the test space at locations remote from the source.</td>
</tr>
<tr>
<td><strong>c d</strong></td>
<td>Identify and suppress causes of temporal variation in field conditions or, if this fails, double the scan-line density on the same segment.</td>
</tr>
<tr>
<td><strong>e</strong></td>
<td>Double the average distance from the measurement surface to the source and keep the same scan-line density.</td>
</tr>
</tbody>
</table>
4. Analysis

After recording the measurement data, it can be reviewed in Analyse mode. Data can be reviewed and exported and depending on the selected options in Ch. setup there are different functionalities available in Analyse mode.

4.1 Logged mode

With option “Store Logged” selected, measurement can be reviewed in Analyse. After having opened the correct datafile, the yellow cursor is used to navigate through the measurement timeline. For each logged point, there is a corresponding set of data stored and available for review in Analyse mode.

4.2 Offline math

In order to be able to use the offline math functionalities, the Sound intensity module needs to be correctly configured before the measurement initialisation in order to store all of the necessary data for the analysis and offline recalculation.

4.2.1 Offline math - recalculation from raw data

With “Store probe channels” checkbox selected, the system supports offline recalculation from raw microphone signals. In offline math, the limits of octave analysis calculator can be edited along with the environmental conditions and all of the results are then recalculated accordingly.

4.2.2 Offline math - Power transformers

A designated procedure is supported in the sound intensity module including the offline recalculation of points from continuous walkaround measurement.

Channel setup

In the channel setup, a correct measurement surface has to be defined for the power transformer. Measurement routine for power transformers consist of two continuous walkaround intensity measurements, one at 1/3rd of height and the other at 2/3rds of transformer height. Meaning the correct measurement surface are all 4 sides of the transformer unravelled into a single rectangle.

For example, if a power transformer is 3m tall, 2m wide and 5m long, the unraveled circumferential rectangle equals 3m by 15m:
In order to be able to perform offline recalculation, "Store probe channels" is selected so that system will store time domain data from both microphones on the probe.

<table>
<thead>
<tr>
<th>Microphone</th>
<th>Channel</th>
<th>SPL [dB]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mic A</td>
<td>AI 1</td>
<td>58.98</td>
</tr>
<tr>
<td>Mic B</td>
<td>AI 2</td>
<td>62.86</td>
</tr>
</tbody>
</table>

By selecting “Store measurement workflow” the system will store the averaging history of octave analysis and will create an octave spectrum for every defined point in post analysis.

As the operator or robotic trolley will move the probe through the measurement, checkbox “Auto next column” needs to be selected. This will enable the user to define a number of columns for recalculation in Offline math.
The user will start and stop the entire walkaround measurement manually, using the remote on the probe, hence ''Auto stop'' checkbox needs to be deselected.

**Measurement**

In "Measure", storing is initiated by selecting "Store" and measurement of individual walkaround is initiated by clicking "Start" or the button on the remote. After walkaround measurement on an individual height is completed, measurement is stopped with "Stop" or by pressing the remote's button again. Below is the intensity map of the transformer with 2/3rd height measurement completed.

**Analysis and recalculation**

After measurement on one or both heights has been completed, storing is stopped and data is available for analysis in "Analyse". Ch, setup can be accessed in Analyse by selecting "Offline Math" and then "Sound Intensity".
In SI ch. setup set calculation to "Offline" in the top right corner of the screen.

The number of segments and averaging time can now be modified and results recalculated accordingly. In order to have 9 points and each point averaged for a second, 9 is input as “Columns” number under “Surface shape” and 1 sec is selected as “Segment Measurement”.

By going back to “Review” tab and clicking “Recalculate”, the system now defines 9 segments/points from the entire measurement and builds an intensity map for the 2/3rd height walkaround. If 1/3rd was measured as well, this would create 9 points on both heights.
If “Store measurement workflow” has been selected in the setup before the measurement, individual octave spectra for each point can be observed. Simply use the yellow cursor in order to move through measurement and the **yellow bracket** on the intensity map will follow.

We will be adding the complete user manual to the website by the end of this week as well.
5. Export & Report

Measured sound intensity and power along with any other acquired quantities can be exported in different file formats as well as to a predefined Excel report for sound intensity based sound power ratings.

Having completed the measurement and stored the data, different export options are available by selecting the Export tab in Analyse mode.

Dewesoft software supports export of data in many different formats allowing the user to customize the file type and range of selected data for export. Additional details about the export functionality can be found on our website: https://dewesoft.com/products/daq-software/dewesoft-x/publish

The results of standardized sound power measurements using the intensity probe are in most cases summarized in a report that includes the end results and information about the measurement setup and conditions. For easier generation of measurement reports there is a predefined excel report template that comes included in the software.

Under the Export section, the Excel option needs to be selected. As reports usually focus on the end result of the measurement - sound power rating of the device under test, only single value channels can be selected for a lightweight export as shown in the picture below.
Export using Sound Intensity excel template by selecting the **Sound Intensity report** from the list of available excel report templates and click **Export**.

The report itself has a predefined **Report** sheet that shows the end sound power result in octave spectrum as well as **overall, environmental conditions, test setup** and **sound source under test** fields. According to the field type they are either pre-field according to the measurement results and settings used in the plugin or they can be edited directly in the excel spreadsheet.

**Please note** that Excel software needs to be closed in order for the export to work. Some difficulties with the Excel programme can be fixed by selecting the experimental feature: **Options->Settings->Advanced->Export->Allow open Excel when exporting**

Besides the predefined report, Excel export creates a **Single value** sheet where additional measurement data can be located and used for post processing.
MEASUREMENT REPORT

Your company name

DATE 2/19/2019
REPORT NUMBER
OPERATOR

TEST SETUP
Standard  ISO 9614-1
Accuracy grade  Precision
Frequency weighting  A
Spacer length  12 mm
Frequency range  200 Hz - 10000 Hz
Resolution  1/3-octave

ENVIRONMENTAL CONDITIONS
Temperature  23 °C
Air pressure  1013.25 mbar
Relative humidity  50 %

SOUND SOURCE UNDER TEST
Manufacturer
Model
Serial number
Operating conditions

SOUND POWER

Lw  56.5 dB(A)

SOUND POWER SPECTRUM
6. Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:
Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED. DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or consequential damages, whether based on contract, tort, or any other legal theory, in connection with the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can be obtained from your local sales and service office. To find a local dealer for your country, please visit https://dewesoft.com/support/distributers.

6.1 Calibration
Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated. Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one year, after system delivery.

6.2 Support
Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties regarding the system. For any support please contact your local distributor first or Dewesoft directly.

Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300
Web: http://www.dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

6.3 Service/repair
The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper operation in the future. For information regarding service and repairs please contact your local distributor first or Dewesoft directly on https://dewesoft.com/support/rma-service.

6.4 Restricted Rights
Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia / Europe.

6.5 Printing History
6.6 Copyright
Copyright © 2015-2019 Dewesoft d.o.o. This document contains information which is protected by copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written permission is prohibited, except as allowed under the copyright laws. All trademarks and registered trademarks are acknowledged to be the property of their owners.

6.7 Trademarks
We take pride in our products and we take care that all key products and technologies are registered as trademarks all over the world. The Dewesoft name is a registered trademark. Product families (KRYPTON, SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are registered trademarks as well. When used as the logo or as part of any graphic material, the registered trademark sign is used as a part of the logo. When used in text representing the company, product or technology name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ® sign is not used in the visual representation of the triangle logo.